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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page nhumber. The humbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP3423 Evaluation Board. ltems discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP3423 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

» Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP3423 Evaluation Board and instructions on how to use the MCP3423
Evaluation Board with the PICkit Serial Analyzer.

+ Appendix A. “Schematic and Layouts” — shows the schematic and layout
diagrams for the MCP3423 Evaluation Board.

+ Appendix B. “Bill of Materials (BOM)” — lists the parts used to build the
MCP3423 Evaluation Board.

© 2008 Microchip Technology Inc. DS51778A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description | Represents Examples
Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

4'p0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {O|l}

Ellipses...

Replaces repeated text

var_name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS51778A-page 2
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP3423 Evaluation Board. Other useful
documents are listed below. The following Microchip document is available and
recommended as supplemental reference resources:

PICkit™ Serial Analyzer User’s Guide (DS51647)

Consult this document for instructions on how to use the PICKit Serial Analyzer
hardware and software.

MCP3422/3/4 Data Sheet, “18-Bits, Multi-Channel Delta-Sigma Analog-to-Digital
Converter with PC Interface and On-Board Reference” (DS22088)

This data sheet provides detailed information regarding the MCP3423 product family.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

» Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com.

DOCUMENT REVISION HISTORY
Revision A (November 2008)

+ |nitial Release of this Document.

© 2008 Microchip Technology Inc. DS51778A-page 3
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Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP3423 Evaluation Board and
demonstrate how to use it with the PICkit™ Serial Analyzer (P/N: DV164122).

The following topics are covered:

* Description of the MCP3423 Evaluation Board
* How to use MCP3423 Evaluation Board with the PICkit Serial Analyzer

1.2 DESCRIPTION OF THE MCP3423 EVALUATION BOARD

The MCP3423 Evaluation Board (P/N MCP3423EV) contains a MCP3423 18-Bit AZ
Analog-to-Digital Converter (ADC). The MCP3423 is a 2-channel 18 bit delta-sigma
ADC device with various configuration options. The board has analog input connection
pads and various test pads.

The user can connect inputs and test the conversion results using the PICkit Serial
Analyzer and its PC graphic user interface (GUI). The MCP3423 Evaluation Board has
the following interfaces:

 PICKkit Serial Analyzer (P/N: DV164122) for writing configuration register bits and
reading the conversion data.

Note: The user can use this board without the PICkit Serial Analyzer as long as
the Vpp, SCL, and SDA are provided through J1 connector. This Evaluation
Board does not include MCU.

The board has test points for SDL, SDA, and analog inputs. By connecting an
oscilloscope to these test points, the user can examine the data communications
through the 12C™ bus line and observe the resulting conversion output. Refer to
Appendix A. “Schematic and Layouts”.

1.2.1 I2C Address Bits and A0 Address Bit Selection

The 12C device code and address bits of the MCP3423 device are:

* Device Code: *1101"

+ A2, A1, AO Address Bits: determined by the JP2 (Adr1 pin) and JP3 (AdrO pin).
« See Table 1-1 for the 12C Device Address bits and JP2 and JP3 connections.

© 2008 Microchip Technology Inc. DS51778A-page 5
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182-002308

. MCP3423
"~ Eval board

CH1 +i=2

kA GND

CH1 —i=

FIGURE 1-1: Front View of the MCP3423 Evaluation Board.

1.3 GETTING STARTED WITH PICKIT SERIAL ANALYZER

Figure 1-1 shows the MCP3423 Evaluation Board, and Figure 1-2 shows the
MCP3423 and PICkit Serial Analyzer.
The following describes how to use them together:

1. Connect the MCP3423 Evaluation Board’s 6-pin socket to the PICkit Serial
Analyzer as shown in Figure 1-2.

2. Connect the oscilloscope probes to the SCL and SDA test pins (optional).
3. Vpp Selection: You can use the Vpp from the PICkit Serial Analyzer or use your
own external Vpp. The JP1 connector selects the Vpp path.
(a) Connect JP1, if using Vpp from PICkit Serial Analyzer.
(b) Disconnect JP1 and apply Vpp at Vpp1 pin, if you are using an external Vpp.
4. Address bit selection using JP2 and JP3 connectors.
The I1°C device code and address bits of the MCP3423 device are:

« MCP3423 I2C device code: ‘1101’

* A2, A1, A0 Address Bits: determined by the JP2 (Adr1 pin) and JP3 (Adr0 pin)

* The JP2 and JP3 connectors are external address bit selections. Connect these
pins to Vgg, Vpp, float, or connect any arbitrary voltage

« See Table 1-1 for the 12C Device Address bits and JP2 and JP3 connections

5. Connecting Vpp: LED D1 turns on when Vpp is applied. The PICkit Serial
Analyzer will provide Vpp automatically, if it is connected to the PC. Make sure
LED D1 turns on, when you execute the command using the PICkit Serial
Analyzer.

DS51778A-page 6 © 2008 Microchip Technology Inc.
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6. Connecting the analog inputs: If you need to measure a single-ended input,

connect the unused pin (example, CHx-) to Vgs.

» Connecting the inputs: The MCP3423 Evaluation Board has input pads for two
analog input channels. You can connect all inputs at the same time and multiplex
the input channel using configuration register settings. You can also leave the
unused channel inputs floating.

7. Use the PICkit Serial Analyzer PC GUI to send I°C write and read commands.

CAUTION

Each analog input pin has an ESD diode. Certain input conditions can damage the
device. Please use the following conditions:
(a) Do not apply an input greater than the input range specified by the MCP3423 Data
Sheet.
(b)Apply the input signal after Vpp is powered-up.

TABLE 1-1: I°C ADDRESS BITS VS. JP2 AND JP3 CONNECTORS

’c De"i;‘i’tsp‘ddress JP2 (Adr1 Pin) JP3 (Adr0 Pin)

1101 000 W/R Connected to Vgg Connected to Vgg
1101 001 W/R Connected to Vgg Float

1101 010 W/R Connected to Vgg Connected to Vpp
1101 100 W/R Connected to Vpp Connected to Vgg
1101 101 W/R Connected to Vpp Float

1101 110 W/R Connected to Vpp Connected to Vpp
1101 011 W/R Float Connected to Vgg
1101 111 W/R Float Connected to Vpp
1101 000 W/R Float Float

Note 1: WIR bit = “0" for writing, “1” for reading.

2: Float: (a) Leave pin without connecting to anything, or (b) apply Addr_Float voltage.

See MCP3423 Data Sheet for more details.

© 2008 Microchip Technology Inc.
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Personal
Computer

USB Cable '}

Connected between the
PICkit Serial Analyzer
and Personal Computer

PICkit Serial Analyzer

Sensor Input Ty il _.

Connectors
“l.-.
_ A W I
MCP3423 Evaluation Board
FIGURE 1-2: MCP3423 Evaluation Board with the PICkit Serial Analyzer.

1.3.1 PICKkit Serial Analyzer PC Software Setup for the MCP3423
Evaluation Board

The following steps describe how to set up and use the PICkit Serial Analyzer PC
Graphic User Interface (GUI).

1. Install the PICKit Serial Analyzer software onto your personal computer (PC).
2. Connect the USB cable between the PICkit Serial Analyzer and the PC.

3. Run the PICkit Serial PC Software - it will open to the following GUI:

DS51778A-page 8 © 2008 Microchip Technology Inc.
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Configuration Wizard E

Welcome To The
PICkit Serial Analyzer
Configuration Wizard

The following steps will guide vou through the
'._f zetup af the PICkit Serial Analyzer.

% Bact " MHext = | Cancel

FIGURE 1-3: PICKkit Serial Analyzer Configuration Window welcome window.

Click the Next button and follow the instructions.

4. Select the Communication Mode type: 12C Master, and click the Next button.

Configuration Wizard E

Communication Mode - Page 1 of 4

Chooze which mode of communication you wish bo uze,

%

[2C Maszter

" 5Pl Master

" USART Asunc

7 USART Spnc Master

¢ Back Mest > Cancel

FIGURE 1-4: Step 1 - Communication Mode selection.

© 2008 Microchip Technology Inc. DS51778A-page 9
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5. In the new window, select “100 kHz” or “400 kHz". Either one will be fine. Click
the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4

Select pour |2C communication speed

Communication speed may alzo be
" 100kHz  adjusted by using the ‘Configure
&+ AD0kHz bode' page from the 'PICKk Senal
Analvzer menu driopdawn after
completing the Configuration
Wizard.

< Back et > Cancel

FIGURE 1-5: Step 2 - PC Communication Speed window.

Note: The MCP3423 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICKkit Serial Analyzer supports the 12C bus data rate
up to 400 kHz only.

DS51778A-page 10 © 2008 Microchip Technology Inc.
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6. Inthe Device Pullups window, select No on “Enable Pull-ups” and click the Next
button.

Note: The MCP3423 Evaluation Board has its own pull-up resistors.

Configuration Wizard |

Device Fullups - Page 3 of 4

Do vou need to enable pullupz for vour device™?

Enable Pullups
(™ Yes & Mo

< Back et ¥ Cancel

FIGURE 1-6: Step 3 - Device Pullups window.

7. In this step, you have to select the Vpp voltage of the MCP3423 Evaluation
Board, then click the Next button.

Case 1: When you use Vpp from the PICKkit Serial Analyzer:

If you choose PICKit Serial will power your device and 5 Volts as shown in
Figure 1-7, the MCP3423 Evaluation Board is powered by the 5V DC from the
PICkit Serial Analyzer through the JP1 jumper. In this case, make sure that the
JP1 jumper on the MCP3423 Evaluation Board is connected.

Case 2: When you use your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at VD1
test point. In this case, make sure that the JP1 jumper is disconnected.

© 2008 Microchip Technology Inc. DS51778A-page 11
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Configuration Wizard

Yoltage Source - Page 4 of 4

Daoes PICKE Serial need to power vaur device?

i Walkage
v FICkit Serial wil
power ry device o
[f PICkit Senal will power your
o Blal device, select the checkbos to
T Other the: left, then determine pour
voltage.

.0

< Back et = Cancel

FIGURE 1-7: Step 4 - Voltage Source selection window.

8. Click the OK button. You have made all of the PICkit Serial Analyzer
Configuration Setups. You are now ready to program the MCP3423 Evaluation
Board using the PICkit Serial Analyzer.

Configuration Wizard

You're Donel

Prezz '0F' to complete the Configuration Wizard.

[ Do wmot show thiz wizard o startup again

“Wizard may be accessed anytime from
renu drapdawn PICKE Senial Analpzer -»
Fun Configuration Wizard.

Ok,

FIGURE 1-8: Configuration Wizard - Finishing step.

DS51778A-page 12 © 2008 Microchip Technology Inc.



Quick Start Instructions

1.3.2 Creating Script Files

In order to make a communication connection between the PICkit Serial Analyzer and
the MCP3423 Evaluation Board, a script file is needed. Figure 1-9 shows how to create
script files and how to use them.

+ In the PICKkit Serial Analyzer window, select from the menu Communications>
Script>Script Builder .

+# PICkit Serial - 12 Master Mode E B

Communications | PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

Basic Operations sic Operations | Reset 12C_M

[ st [ sopuider | ~ B
M Update

B Executive Error
B Communication Error

I 12C Errar
" i -o)x
Transactions BitRate: 100.0 kHz

5 . Source Woltage: 4.8%
File » Edit » Clear Data Line Woltage: 484
Clock Line Woltage: 4.74

Script Execute

02/13/2007 4:59:14 FM

Welcome to PICkit Serial wersion 2.0.1.0

Found PICkits5.d11 - Ver: 1.3.0.0

Found PICkit Serial Analyzer - FW Ver: OxD108
USE control block updated with preference data.

Basic Wiew Set.

FIGURE 1-9: Creating a script file with Script Builder.

1.3.2.1  CREATING SCRIPT FILE FOR CONFIGURATION BYTE WRITING

1. Click on WriteBlockAddrA8 in “Example 1°C Scripts” column.
This will result in filling in the spaces under the “Script Detail” column.

You can now modify the “Script Detail” column parameters by right-clicking the
mouse.

How to modify the parameters box in Script Details:

1. Under the “Script Detail” box, select the item in the parameter box.

2. Right click the mouse button and an option box appears to the right of your
selection. These are the options available for the parameter selected.

3. Select the desired option and delete or insert the parameter box.
4. Keep the parameters in order as shown in Figure 1-10:

© 2008 Microchip Technology Inc. DS51778A-page 13
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il P|Ckit Serial - 12C Master Mode

Communicakions  PICKiE Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window  Help

View: Basic | Communications: Basic Operations | Reset

5cript Builder -|Tp=
m | Emample [2C Scrptz —— 7 Scnpt Detal | User [2C Scrpts 1
_ Script-Mame [ Headﬂ.ddrﬂﬂ I2CSTART = I'-.-1F'44 Genalfl'-. -
[MCP2423_wirt_CH1 WiiteAddiAg | 3 '
WiriteBlockAddrd g JI 20WRTEYT
i FeadBlockaddisd ]EIE
Save Script s
oC ®
E zecute Script /> J
1. Tochange value: IE": =
Clear Script A N (FTS i]2 I
2. To delete or Insert a new box:
» Choose the box and right I H
& click the mouse button
Del User Scripts for options available J =
3. Make sure the listed I =
parameters in “script Detail”
Show Array are in the exact order as J 2
shown here.
| ®
| x
| ®
| x| o =
FIGURE 1-10: Modifying parameters in Script Builder window.

4. Change the parameter value:

Script Detail

[2CSTART *

[2CWRTBYT | *
02 —»This means there are two bytes to send

DC ———»1st Write Byte: Address byte with W/R bit = 1101-1100
9C —»2nd Write Byte: 1001-1100

[2CSTOP *

Note: All six parameters above must be listed in order. The parameter above
marked with * character are not modifiable. Address bits (A2, A1, A0) =
(1,1,0) if both JP2 and JP3 are tied to Vpp. You can use different address
bits by rearranging the connectors. See MCP3423 Data Sheet for more
information on address bit sections.

DS51778A-page 14 © 2008 Microchip Technology Inc.
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ool PICkit Serial - 12C Master Mode
Communications.  PICkit Serial Analyzer  Demo Boards  User Defined Templates:  Wiew  Window  Help

View: Basic | Communications: Basic Operations | Resek

Script Builder = ) B

- Example [2C Scripts — Script Detail | Userl2C Scrptz
el B o — Y
MCPE423 wit_CHI AL 2820 e L
I =t WiniteBlockaddrag 1I2E‘WHTEYT MCP3423 wit_CH:
= ReadBlockAddrsd 02
Save Script ‘ ] X
|oC x
Execute Script | 2 Bytes to send 19': =
Clear Script | l2C5T0P il
|
=
Del User Scripts ‘ Configuration Byte | 5
(9C) | =
Show Array ‘ | "
| ®
| %
| ®
| x o =

Note: The “9C” in the configuration byte selects the following options:
- Conversion Mode: Continuous Conversion
- Channel Selection: Channel 1
- Bit Resolution: 18 bits
- Gain Selection: 1x

FIGURE 1-11: Script file example for PC Write Command.

1.3.2.2 SAVE THE SCRIPT FILE AND PROGRAMMING THE MCP3423
CONFIGURATION REGISTER

1. Change the 2" and 3™ data bytes you want in the Script Detail.
2. Type in any script name (i.e., MCP3423_ Write) in the space below the “Script
Name” menu.

3. Click Save Script button.
4. Click Execute Script button.

Note: At this point, the PICkit Serial transmits the I2C Write Command to the
MCP3423 device. The saved file name will appear in “Users 12C Scripts”
column, and can be re-used any time by selecting the file name.

© 2008 Microchip Technology Inc. DS51778A-page 15
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5. You can also see the SCL and SDA waveforms using the Oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 1°C
command.

Write Command with Address bits Configuration Bits

FIGURE 1-12: PC Write Command Waveforms for the MCP3423.

DS51778A-page 16 © 2008 Microchip Technology Inc.
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1.3.3 Trouble Shooting: If the device does not acknowledge the
commands

If the device is powered up initially with unstable Vpp from the PICKit Serial, there is a
chance that the device can latch a wrong address bits from the external address pins,
and therefore it may not acknowledge the command bytes correctly since the address
bits are not matched. In this case, send a General Call Latch Command after the Vpp
is stabilized (after about 20 seconds the PICKit Serial is powered). See the example in
Figure 1-13. Another method is power-up the PICKit Serial first by connecting to the

PC, then insert the MCP3423 EV board to the PICKit Serial about 20 seconds later.

(a) The device
does not
acknowledge the
write command.

N

NAK Pulse NAK Pulse

(b) Send a
General Call
Latch Command.

(c) The device
now acknowledge
the command.

ACK: Pulse / ACK Pulse/

FIGURE 1-13: Examples when the device is not acknowledging the write command. Send the
General Call Latch Command when the Vpp is stabilized.
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1.3.4 Reading the Conversion Data using the PICKkit Serial Analyzer

You can read back the conversion data with the following steps.

1.3.4.1 CREATING SCRIPT FILE TO READ CONVERSION DATA

1. Click on ReadAddrA8 in “Example 12C Scripts” column.
This will result in filling in the spaces under “Script Detail” column.

Now you can modify the parameter boxes (delete or insert) in the “Script Detail”
column with options. The list of options will appear if you right-click the mouse in
the parameter box. You can delete the parameter box or add a new one.

2. Make sure you have the “Script Detail” parameters listed in order as follows:

Script Detail
[2CSTART *
[2CWRTBYT *
01 —— This means there is one byte for address
DD —» Address byte with W/R bit = 1101-1101
[2CRDBYTNLB | *
5 — 5 bytes to read
[2CSTOP *

Note: All seven parameters above must be listed in order. The parameters above
marked with * character are not modifiable.
Address bits (A2, A1, A0) = (1,1,0) if both JP2 and JP3 are tied to Vpp. You
can use different address bits by rearranging the JP1 and JP2 connectors.
See MCP3423 Data Sheet for more information on address bit selections.

DS51778A-page 18 © 2008 Microchip Technology Inc.
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il PICKkit Serial - 12C Master Mode

Communications  PICKiE Serial Analvzer  Demo Boards

View: Basic | Communications: Basic Operations = Reset

User Defined Templates

Script Builder =

Wiews  Window  Help

Example 12C Scripts Scrpt Detal Ilzer [2C Scnpts
Script M ame A eadtddra s |I2I:ST.-“-‘-.F!T = MCF3424 GenCald a
||"-"||:F'3423 Read Writed ddrd g MCP3423 Wit CHT
= WiiteBlockaddras |I2E"-’JHTBYT MCPI423 Witk CH:
T FeadBlockAddriad |EI1 MCF3423 Read
Save Script ‘
i DD
Execute Script | |I2I:FEDBYTNLE
.
Clear Script ‘ |5 AL
{l2csTOP
Del Uzer Scnpts | R%q;;z:lsng |
Show Amray | |
FIGURE 1-14: Script File sample to read conversion data.

3. Type in any script name (i.e., MCP3423 Read) in the space below the “Script

Name” menu.

4. Click Save Script button.
5. Click Execute Script button.

Note: At this point, the PICKit Serial transmits the 1°C Read Command to the
MCP3423 device. The saved file name will appear in “Users 12C Scripts”
column, and can be re-used any time by selecting the file name.

6. You can also see the SCL and SDA waveforms using the Oscilloscope.

Note:

command.

When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 1°C

© 2008 Microchip Technology Inc.
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a® PICkit Serial - 12C Master Mode

Communications  PICKE Serial Analyzer  Demo Boards  Llser Defined Templates  Yiew  Window  Help

View: Basic | Communications: Basic Operations | Resek

Script Builder _[elx]

Example |2C Scripts —— Scopt Detal 0 Ilzer |2C Scripts
Script Name Feadtddrsd ]IEEST.-*-.FET =l MCF3424 GenCald «
| |M|:F'3423 Fead wiritedddra g MCP 3423 it CHTT
= WiriteBlockAddral ]IEEWHTBYT MCF3423 wit CH:
5 FReadBlockaddridd |EI1 MCE3423 Read
Save Scrpt ‘ *
|DD x
Execute Script ‘ ]IEEHDEYTNLB
Clear Scnpt ‘ ]5 3| Pt
l2C5TOP
Del Uzer Scnpts ‘ Requesting ] x
5 Bytes I =
Show Array ‘ ] -
| ®
| x
| ®
| o =

File = Edit = Clear

10:24 44 AM Sent script from Script Builder page, 10
bhytes:

[5_1MW_J[01]1[EOI[RNI[@STIP_] _Reading Data
R using a Read Command
A AT A A

5th Byte: Repeated Byte for Configuration byte
4th byte: Configuration Byte (note that RDYbit is “0”)
3rd byte: Data Byte

2nd byte: Data Byte

1st byte: Data Byte

Results:
Output code: F907 in hex ( = 63751 in decimal)
Output Voltage= 63751 x 15'625P GVA LSB) - 0.996 Volts with PGA= 1

Note that if the differential input voltage is negative (CH- > CH+), the MSB of the first byte will be "1". In this case, the
voltage is calculated after converting the output code to 2's complement and then multiply the LSB.

See Section 4.9 of the MCP3423 Data Sheet (DS22088) for more information.

FIGURE 1-15: Reading Conversion Results: Note that the Input = 0.996V is applied to CH1. The
reading indicates the measured value is 0.996 Volts.
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-
4

Data Bytes = 00F907 (hex)

(a) Read command and outputs. The 3 data bytes are zoomed in for better clarity.

Zoom-in

g ! L prm

Configuration Byte (4th) and Repeated Configuration Byte (5th)

(b) Read command and outputs. The last two data bytes are zoomed in for better clarity.

FIGURE 1-16: Read Command and Data on IPC bus. Note the RDY bit in 4th byte is “0”. This means
the conversion data just read is the latest conversion data. The RDY bit becomes “1” in the 5th byte
(repeated byte). This means the device is now in the process of new conversion and the new result is not
ready yet.
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